SAP BusinessObjects BI Pattern Books

ABSTRACT

Upgrading from BOE XI 3.1 to
SAP BusinessObjects BI 4.2

This pattern book
covers the workflow
required to UPGRADE
objects from the
source (BOE XI 3.X
platform) system to
the target (SAP BI 4.2
platform) system
deployed on
Microsoft Windows
platform.

Disclaimer





This pattern book is for informational purpose only and may not be copied / reproduced
without the permission of SAP
The information provided in this book are based on the SAP BI Pattern Books project for
a specific set of patterns / use cases applied within SAP lab environment. Hence, make
sure to review and apply the steps / workflows that are applicable to your use cases /
patterns, based on your SAP BusinessObjects BI landscape
Contents of this, or any related document and SAP's strategy and possible future
developments, products and or platforms directions and functionality that are discussed
in this book all subject to change and may be changed by SAP at any time for any reason
without notice. Therefore, read the latest official product guides, release notes to
understand the differences and act accordingly

For further comments and questions, email to SAPEnableBI@sap.com
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What is SAP BI Pattern Books?
A pattern book is a step by step 'how to' of an actual deployment / upgrade of SAP
BusinessObjects BI software documented as precisely as possible, based on a particular
pattern/use case (for example: Deploying BusinessObjects on Windows Operating System).
The main goal of the BI Pattern Books project is to produce books that can be used as an
instruction manual that provides step by step instructions on how to successfully deploy / test /
upgrade SAP BusinessObjects BI software using a live example and how it was technically
achieved.
Previous phases of BI Pattern Books:


BI 4.1 Release – SAP BI Pattern Books - Pattern Book on BI 4.1 Upgrade and SAP BI



Pattern Books - Pattern Book on BI 4.1 Update
BI 4.0 Release - BIP on Linux with Tomcat and Sybase ASE Pattern Book and BIP on
Windows with Mobile and Explorer Pattern Book




BOE XI 3.1 Release - on Windows Pattern
BOE XI R2 Release - on Linux and AIX Patterns

Abbreviations
UMT
CMC
CMS
IFRS
OFRS

Upgrade Management Tool
Central Management Console
Central Management Server
Input File Repository Server
Output File Repository Server
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Overview
Largely, it’s a two steps process when it comes to upgrading from earlier BOE XI 3.x release to
the latest BI 4.2;
1. Step1: Installing and configuring brand new BI 4.2 system
2. Step2: Moving objects (users and reports etc.) from source to target system
This pattern book has been developed by running the workflow of moving source system
(BusinessObjects XI 3.1) objects into the target system (BusinessObjects BI 4.2) using the
Upgrade Management Tool (UMT) that is part of the BusinessObjects BI suite.

Pre-requisites: Upgrading from BOE XI 3.1 to BI 4.2
These are the important pre-requisites required to perform an upgrade project;




Connectivity: Network connectivity and access to BOE XI 3.1 (source) and BI 4.2 (target)
machines
UMT Access: This is required to make sure that UMT designated system can connect to
the source and target system without any issues
Admin Privilege: Administrator privileges for the designated user who runs UMT on a
server, which is on Windows operating system

System Architecture
Before planning for an upgrade, make a note of necessary details like BI content (number of
users, groups, folders, universes, and so on) and deployment of source and target systems,
which can be used for post upgrade validation.

Source System

Architecture highlights
Here are the main highlights of the SAP BusinessObjects XI3.1 SP07 source system landscape:






Clustered
Load Balanced
Reverse Proxy Supported
SSL Secured
Windows AD (with SSO) and SAP Authentication Supported

Source software components and their versions.
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The following table summarizes the software components used, with their version information:

Software

Type/scope

Version

Tomcat

Web Application Server

6.0

SAP BusinessObjects
Enterprise platform

BO application server

SAP BusinessObjects XI
3.1 SP07

MS SQL Server

Database server for CMS and
Audit databases

MS SQL Server 2008 R2

Microsoft Windows

Operating system

Windows 2008 R2 SP01
(64 bit)

Apache

Web server / Reverse Proxy /
Load Balancer

Apache 2.2.9

Source system landscape and components
The following diagrams show the technical architecture of the SAP BusinessObjects XI 3.1 SP07
(DMZ) environment used in this pattern. Each server node is identified with the logical name
corresponding to the architecture components it hosts:

Upgrade assessment (infoobjects) summary
Make a note of all the objects in the source repository. In this pattern, there are about 88825
objects in the repository, which are mentioned below:

Public folder content
Object Type

Object Count

AF Dashboard pages

124

Agnostic documents

523

Crystal Report instances

22023

Crystal Reports

11790

Desktop Intelligence report Instances

18

6

Desktop Intelligence reports

580

Events

42

Flash Objects

521

Hyperlink Objects

420

LCM Jobs

51

Microsoft Excel documents

117

Microsoft PowerPoint documents

25

Microsoft Word documents

14

Object Package Instances

0

Object Packages

527

OLAP documents

10

PDF documents

5

Program Objects

240

Publication instances

1694

Publications

642

QaaWS Objects

894

Repository Objects

1533

Shortcut objects

2619

Text documents
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Web Intelligence report Instances

3566

Web Intelligence reports

8270

Xcelsius objects

304

User and user groups
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Object Type

Object Count

Enterprise Groups

32

Enterprise Users

674

SAP BW Groups

2

SAP BW users

25

Windows AD Groups

3607

Windows AD Users

24500

Other CMC objects
Object Type

Object Count

Replication lists

2

Public folders

182

Profiles

7

Corporate categories

3

Calendars

2

Applications

12

Access controls

45

Universes and connections
Object Type

Object Count

Universe

1387

Universe Overloads

610

Connections

1175

Voyager connections

6
8

Source System Architecture
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Target System
Following are the Target System details:
Machine Type

Machine Name

WS + WAS 1

WINPB05-08

WS + WAS 2

WINPB05-09

CMS1

WINPB05-02

CMS2

WINPB05-03

BI AS1

WINPB05-04

BI AS2

WINPB05-05

SBO Explorer

WINPB05-01

CMS DB

WINPB05-07

Target System Architecture
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Planning your Upgrade
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These are the recommended steps to apply / follow while planning your upgrade .

Determining your Upgrade Model
There are two ways (aka options) to upgrade your objects from BOE XI 3.1 system to BI 4.2
systems:
1. Complete / Full Upgrade – moving all objects at one shot from source to target
2. Incremental Upgrade – moving objects in batches as iterations
Generally speaking, complete upgrade is suitable for small scale BusinessObjects deployments,
whereas incremental upgrade is recommended for any medium, large scale deployments.

Configuring Upgrade Management Tool
The upgrade management tool guides you through the process of exporting business intelligence
content (user accounts, groups, folders, reports, universes, security, and other objects) and upgrading it
to the most recent version. You need to configure it for better performance.
1. To run UMT with more Java Heap memory, use the Java –Xmx command-line argument (Eg: Xmx15g) when launching UMT.

a. Right Click on “Upgrade Management Tool” an go to”Properties” under the
“Shortcut” tab.
b. Copy the “Target” path to Notepad.
c. Replace above “Xmx<>” with amount of Heap configure for your system.
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2. Configure the timeout settings for UMT.

13

The target details of the UMT is shown below:
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Note: The following error might occur during dependency computation;
com.crystaldecisions.thirdparty.org.omg.CORBA.NO_RESPONSE: Timeout
To resolve this issue, you need to increase the CORBA timeout for UMT, increase the timeout
for input and output FRS servers, modify CMS server properties, and increase connections to
system (CMS) database.
Note: for better performance and throughput, it’s recommended to install and run the UMT on
a dedicated server. This can be a temporary server, which can be dismantled once the Upgrade
is completed. And it’s important to install the UMT with SIA on this temp server for CMS
connectivity.

Increasing CORBA Timeout for UMT
Modify the upgradeManagementToolSystem.properties file located at C:\Program Files
(x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI
4.0\java\apps\upgradeManagementTool\jars by adding the below entry:
<entry key="umt.systemVar.backendCommunicationTimeoutInMS">630000</entry>
Note: If you increase the value to more than 630000, then the logon to CMS would not occur.
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Modifying System (CMC) Properties
Increasing input and output FRS servers timeout in source and target
systems
1. Logon to CMC, go to the properties of Input & Output File Repository Servers. And change the
'Maximum Idle Time' value as shown below:
2. Go to Properties of Input & Output File Repository Servers.
3. 3. Change the Maximum Idle Time value as shown below:
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Modifying CMS server properties in source and target systems
Similarly, modify the CMS server 'Command Line Parameters' as shown below;
-loggingPath "C:/BOEXI3_1/BusinessObjects Enterprise 12.0/logging/" -maxobjectsincache
100000 -threads 150 -nbqthreads 10 -startedBySIA

Increasing the connections to system database in source and target
systems
Similarly, go to CMS server properties and change the "System Database Connections
Requested" as shown below:

Note: For the changes to effect properly, it’s recommended to restart the SIA.
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UMT Connectivity Testing (Source & Target)
Launching UMT and logging on to the source and destination systems:
1. Go to Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI Platform4 >
Upgrade Management Tool.
2. Right-click Upgrade Management Tool and select Run as administrator.

3. Select Incremental Upgrade and click Next.
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4. From the Upgrade Scenario drop-down list, select Live to Live. Give CMS Name for source and
target system, enter credentials.

5. Enter CMS Name for source and target system.
6. Enter credentials.
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7. Click Next.

Preparing your Upgrade
Now that you planned out your upgrade by checking the pre-requisites and other important
aspects of your BusinessObjects environments, this section tell you what you need to do before
executing or running your upgrade.

Disabling Default System Updates
We recommend you to disable the default Windows update and stop anti-virus process in all
machines (in both source and target systems).
Following are the steps to disable 'Automatic updates' for Windows and JAVA auto-update to
avoid any ad-hoc updates that may force restart the machine, affecting the upgrade process.
1. Go to Start > Run.
2. Type services.msc.
3. Right-click Windows Update and select Properties.
4. Click Stop.
5. From the Start up, Type drop down list, select Disabled.
Similarly, do this for any automatic or scheduled updates for software installed on your
Windows machine.

Pausing Scheduled Instances
Before performing the upgrade workflow, we recommend you to pause all the scheduled
objects and delete unwanted and failed object instances in source system. Because, recurring
schedule instances can interfere with the system tasks and can increase overhead on the CMS.
Following are the steps to pause scheduled instances: Log on to Central Management Console
(CMC) as administrator.
1. Log on to Central Management Console (CMC) as Administrator.
2. On the CMC Home, select Instance Manager from the drop-down list.
3. Select the Status option and select Pending to filter all the instances that are either in
‘Pending’ or ‘Recurring’ status.
4. Select all the instances and choose Pause from the menu bar.
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All document schedules will be paused.
5. Similarly, delete all unwanted failed instances.

Clearing CMS Temp Storage
You need to clear the CMC temporary storage in the source system to avoid issues as
mentioned in the knowledge base article - 1889161 - UMT fails with a timeout during receive
and Corba connect errors while retrieving users and objects.
1. Log on to CMC as Administrator.
2. On the CMC Home page, under the Organize section, choose Temporary Storage.

3. Select all the content.
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4. From the Manage menu, select Delete.

Running RepoScan
We strongly recommend that you run RepoScan tool in order to identify object inconsistency
and make sure the repositories (CMS and FRS) are in complete sync.
Run RepoScan with -repair option. For more information on how to use RDT, see the Repository
Diagnostic Tool guide.
We recommend that you read the following reference KBA article for information on how to
run RDT: 1689163 - How to use the Repository Diagnostic Tool (aka reposcan) in BI 4.0 - for
WINDOWS
1. Go to the target CMS system and create a .ini file as mentioned in the above KBA. For
example, reposcan40_options.ini.
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2. Create a folder ‘Downloads’ in the C:\ drive and save the above file.

3. Open the command prompt and navigate to C:\Program Files <x86>\SAP
BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\win64_x64.
4. Run reposcan.exe by using the configuration file as shown below:
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The following xml files are generated at C:\Downloads:
 Repo_Repair_YYYY_MM_DD_hh_mm_ss.xml
 Repo_Scan_YYYY_MM_DD_hh_mm_ss.xml
5. Refer the xml files for the details of the scan and repair operation (if any).
6. Repeat this on the source CMS system.
For more information on RepoScan, refer to wiki How to use Repository Diagnostic Tool
(reposcan)

Running Platform Support Tool
We recommend to run the SAP BusinessObjects BI Platform Support tool on the target system.
The BI Platform Support Tool is a new Java based utility. This tool is used by support engineers,
consultants, and BI administrators to inspect the BI Enterprise system configurations, perform
root cause analysis, and deliver performance optimization and go-live services. .
You need to run the platform support tool to get the report of the existing system landscape of
BI 4.2 system before upgrade.
1. Launch the SAP BI platform support tool.
2. Select Analysis.

24

3. Select all the options to generate the consolidated report before upgrade.

4. Click Next.
5. Enter the CMS machine name (for which you want to generate the landscape report),
user name, password, and authentication type.
Cluster name is not accepted here. But, the tool will capture the details for the entire
clustered landscape.
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6. Click Log On.

After authentication, BI landscape inspection report is generated. This report contains
landscape, server comparison, license key, content, and schedule inspection details.
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7. Go to the Alert Summary section to check if there are any anomalies.

In this pattern, we have hosted all the APS services on a single SIA, therefore, the metric
APS service is showing an alert. For information on how to split APS server using System
Configuration Wizard under the section "Restart all SIAs".
8. Check if there are any anomalies in the other areas.
9. From the File menu, select Save Landscape Analysis to save the inspection report in a
folder. For example,landscape_report_4.0_before_update.zip.

Disable auditing on source and target systems
Disable auditing on the source and target systems to prevent logging of events and avoid
performance issues.
1. Launch Central Configuration Manager (CCM) on the source system.
2. Stop SIA.
3. Right-click SIA and choose Properties.
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4. Under the Configuration tab, uncheck Write server audit information to specified data
source.

5. Log on to target CMC as administrator.
6. On the CMC Home page, select Auditing from the drop-down list.
7. On the Auditing page, turn off auditing by moving the slider.

Enabling Authentication Types
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Following are the steps to Enable Windows AD and SAP authentication types on the source
system:
Note: Do not Disable Windows AD and SAP authentication types on the source system
If the target system has access to the SAP system and the Domain controller, then keep the
Windows AD option and SAP authentication enabled in the source systemLog on to CMC as
administrator.
1.
2.
3.
4.

Log on to CMC as administrator.
On the CMC Home page, select Authentication from the drop-down list.
Double-click Windows AD
Check Enable Windows Active Directory (AD) option and click Update.
Note: If you map the AD groups in the Destination system in Mapped AD member Groups and
then click on update before running Upgrade Management Tool, this maps all your AD users in
Domain controller to target system. Destination system reflects the AD user groups and users in
destination. However, the inboxes, personal folders, and dependencies for the respective users
will not be reflected. Also, the CUID of the groups and users will be different compared to
source and destination systems. This should be used as a last resort when we know that the AD
controller cannot be connected to destination system prior to upgrade.
Note: If you enable Windows AD configuration in the source and forget to enable Windows AD
configuration in destination, then during the upgrade process, the user groups and the users
will be selected. And, Upgrade management Tool will not give any error during the upgrade.
However, on completion, in Mapped User Groups under ‘AD authentication’ tab in destination
system, you will be able to see the user groups. But, the users will not be listed in the users list.
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5.

Double-click SAP and choose the Options tab.

6. Check Enable SAP Authentication option and click Update.

EnablingWindows AD and SAP authentication types on the target system
Enabling Windows AD and SAP authentication types on the target system is a mandatory step
prior to the upgrade process, if the users want to bring in third party users from the source
system. This should be performed in the destination system.
1. Log on to CMC as administrator.
2. On the CMC Home page, select Authentication from the drop-down list.
3. Double-click Windows AD.
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4. Select Enable Windows Active Directory (AD) and provide username and password.

5. Click Update.
Note: Do not add any Windows AD domain groups as they will be added during upgrade.
6. Double-click SAP and choose the Options tab.
7. Select Enable SAP Authentication.
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Note: Do not import any roles at this point in time. The roles will be added during the

upgrade.

Stopping BI Platform Servers
Source system:
Only servers such as the CMS, Input & Output file repository servers (FRS) are required to be up &
running. Preferably, stop all other servers to avoid any system overhead and unwanted server activity
during upgrade.
In a clustered or Distributed environment, run only one CMS server, one Input FRS & one Output FRS
servers of the same SIA; with the rest of the servers and SIA nodes stopped..

Target system:
Servers to be up and running:



Central Management Server
Input & Output File Repository Servers
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Connection server (for dashboards)
Adaptive Processing Server hosting the Multi-Dimensional analysis service (MDAS) and



Crystal Report Application Server (for Crystal Reports) with rest of the servers stopped.
In a Clustered or Distributed environment, run only one set of the above said servers of the
same SIA and rest of the servers, SIA nodes stopped.

Creating Data Source Connections
Creating OLAP connections on the target system
Voyager workspaces are upgraded by the Upgrade Management Tool. However, you need to
perform certain tasks before and after running the Upgrade Management Tool to upgrade
workspaces.







You can only upgrade Voyager workspaces from SAP Business Objects Enterprise XI 3.1
or later to SAP Business Objects BI 4.2
Connection prompts are not supported during conversion. You need to change the
connection to either SSO or pre-defined in the source system. After the upgrade, you
can change the connection to prompt in the target system.
OLAP connections must be recreated in BI 4.2 before running the Upgrade Management
Tool. The new connection name must be identical to the SAP Business Objects
Enterprise XI 3.1 OLAP connection. Otherwise, the Voyager workspace will not be
upgraded.
For Voyager of SAP BW, mandatory variables without default values will fail. To avoid
this, modify the query in the Query Designer to specify a default value prior to upgrade.
After the upgrade, you can set it back to the original value.

New features in UMT SAP BusinessObjects BI 4.2:







In BI 4.2 we have a couple of new features that can be preset before the migration.
We can select the log level to low, medium and high from the drop down menu.
High will capture all the errors, warning and failures during the process.
We also have the feature to set the temp space to our desired directory. Here it is set to
C:\temp.
Once the temp is set, you will receive a prompt to re-launch the UMT tool. This is by
design.
The temp space will contain all the entries of Derby Database as shown in the
screenshot. On successful completion of migration to BI 4.2 they can be removed.
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Upgrade Workflow: Upgrading from BOE XI 3.1 to SAP
BusinessObjects BI 4.2
The following is the quick summary of the number of iterations and their scope (what’s actually
included in that iteration to migrate from source BOE XI 3.1 to target BI 4.2);

Iteration
Iteration #1

Iteration #2

Scope
In this iteration, the following objects were migrated with their
dependencies;
 User groups
 Access Levels
 Applications
The same approach can be used for all user groups, all access levels in a
single iteration however this can be time consuming based on the number
of objects etc. Therefore it’s recommended to decide on the number of
iterations based on your repository objects.
The following objects were considered for upgrade with dependencies.
You can select these objects for migration in the Object selection screen:
 Folders and Objects
 Repository Objects
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Iteration #3

Iteration #4

Iteration #5

 Universes
For this pattern book, we have done the migration in a single iteration.
However, depending upon the number of objects, this iteration can be
time consuming. Therefore it’s recommended to decide on the number of
iterations based on your repository objects.
In the initial “Select Filter” screen, the time filter was set according to the
requirement. In our pattern book, we are selecting the start date as
02/01/2016 and the end date as 02/05/2016. So only the following objects
will be listed and migrated;
 Universe – Universe modified between the start date and end date
mentioned in the select filter
 Web Intelligence Reports – Reports modified between the start
date and end date mentioned in the select filter
The following objects were considered for upgrade with dependencies.
These are the objects selected for migration in the Object selection screen:
 Applications
 Calendars
 Corporate Categories
 Profiles
 Remote Connections and Replication Jobs
 Repository Objects
 Universes
In this iteration, all the content dependencies (related to all the
documents) were set to be upgraded first. However, this can also be done
in increments.
Note that any objects that have already been migrated will not be listed in
the object selection screen again in this iteration as we are using the
feature “Hide objects which are already upgraded” from the selection filter
screen.
The following objects were selected for upgrade with dependencies;
 Public folders and their objects, except those objects that were
upgraded in iteration 2
 QaaWS objects
 Events
 Mobile Subscriptions
 Object dependencies will be listed in UMT but will be unselected
later
For this pattern book, we have done the migration in a single iteration.
However, depending upon the number of objects, this iteration can be
time consuming. Therefore it’s recommended to decide on the number of
iterations based on your repository size and number of objects.
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Iteration 1
In Iteration 1, we are performing an incremental upgrade and bringing in a subset of AD and
enterprise and SAP users along with their custom access level aligned for the applications.
1. Select the desired language. For our scenario, we have selected “English”.
2. Select “Incremental Upgrade”.
3. Select the Log Level “High”.
The log would be located at <INSTALl_DIR>\SAP BusinessObjects\SAP BusinessObjects
Enterprise XI 4.0\Logging. You can have a look at the log files if you face any issues or to
check the completeness of the migration.
4. Set the temporary folder location according to the user preference. For this scenario, we
have selected the destination as “C:\Temp”.
5. Choose Next.

6. From the Upgrade Scenario drop-down list, select Live to Live
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7. Choose the “Save Credentials for future usage” check box to store your CMS and User
Name details.
Note: The password will not be stored for next usage as it is a breach of security.
8. Choose “Next”.

9. If the credentials are correct, user will be logged in to the Source and Destination CMS.
If the credentials/system information is not correct, an error message would pop asking
the user to provide appropriate details.
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10. DO NOT check any options while migrating the user groups. Ensure that everything is
left as it is and choose ‘Next’.
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11. Choose ‘Users and User Groups’ and choose Collapse or expand icon.
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12. Select the “WebiUsers” group that contain the AD users.
Note: When you select AD user group on the left hand side of the panel, the corresponding
users would get displayed on the right hand pane only if Windows AD Authentication is enabled
in the source system. SAP recommends to have Windows AD enabled in the source and target
system while migrating from 3.x to 4.x.
If AD user group is selected on the left hand side by default, the AD users on the right hand pane
will be selected with “Export objects and its dependencies”. User will not be able to change this,
as this is by design and can only be changed if the corresponding AD user has an Enterprise user
alias.
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13. Here we are selecting 2 more groups. OlapUsers and Xcelsius. Users which contain both
AD and Enterprise Users and SAP users.
14. Choose Options.
15. Retain the default options shown, as you are migrating for the first time.
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16. Here we have selected “Applications”. On the right hand side, choose ’Select All’. Ensure
that on the right hand pane, “Export Selected Objects” is selected.
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17. Select “Custom Access Level”. Here, we have selected the Custom Access Level that has
been assigned to the user group.
18. The custom access level for “Olap” User Group is “Olap_AC”. Select the custom access
level “OLAP_AC” and select “Export this Object”.

19. In a similar pattern to the above, the Custom Access level for “Xcelsius” User Group is
“Xcelsius_AC” and for “WebI“ User group is “WebIUsers-AC”.Ensure that “Xcelsius_AC”
and “WebIUsers-ACi” are selected and click on “Export this Object”.
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20. Once the respective User Group, Applications, and the Custom Access levels are
selected, choose Next. The object retrieval screen pops up successfully, indicating how
many objects are being retrieved.

In the below screen, since Crystal reports and OLAP intelligence reports are being
upgraded, a warning message will be presented asking you to confirm if the Adaptive
44

Processing server (APS) hosting the multi-dimensional analysis service (MDAS); and
Crystal Reports 2016 Report Application server hosting 'Crystal Reports 2016 Viewing
and modification service' are running and enabled on the target system.
Ignore this if the servers are already enabled in the target system. Otherwise, the
servers need to be started (before proceeding with UMT next step) for successful
migration of the above mentioned reports..

21. Choose OK. Refer to the Known Issues and Challenges section on how to rectify this
issue.
The reason why we see User Inboxes, Universes, User Favorites, Personal Categories and
Folders and Objects even though we have not selected them for migration because they
are a part of dependency of the users and groups. All the dependency of the Users and
Groups whom we had selected would appear here.
Users can also manually de-select the objects based on the criteria or requirement.
However, it is recommended to bring in all the dependencies.
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22. Choose Upgrade Options.
23. We will go with the default values as we are migrating for the first tim
24. Choose OK.
25. Choose Start.
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You will see a progress bar after choosing “Start”.
The performance or time taken for the migration would depend on the memory and the
UMT Tuning. Refer to Upgrade pre-requisite section to know more about the tuning of
Upgrade Management Tool for better performance.
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Once the upgrade is successful, you see the “Upgrade Completed” pop-up message along with
the number of objects that have failed (if any) and the reason behind failure of those objects.
You can also find the logging file, as mentioned before, to check for any information
pertaining to an issue or completeness of the migration.

The errors and warnings have been discussed in the known issues and challenges section.
Refer he known issues and challenges section for more details on the error and how to
resolve the same.
The same workflow can be followed if you want to bring in all the user groups along with all
the custom access levels along with all applications and dependencies. However, it is
recommended to bring in incremental basis with a smaller subset and also to run RepoScan
in the source system and check for any inconsistency between the source CMS and FRS. If
there are any inconsistencies, it can be repaired using RepoScan repair command line
arguments.
Refer the ‘Upgrade pre-requisite’ section for more details on RepoScan. Also, check the prerequisite for AD and other third-party authentication.

Iteration 2
This iteration illustrates you to move all the object of different types and their dependencies to
the target system.
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You need to scan the RepoScan on the source and if there are any inconsistencies between the
CMS and FRS, the RepoScan repair should fix the issues. For more information on repo scan, see
the XI 3.1 to 4.1 upgrade pattern book (how to Upgrade from BOE XI 3.1 to BI 4.1)
1. Launch the Upgrade Management Tool.
2. Select Incremental Upgrade.
3. Choose Next.

4. Enter the Destination and target system details.
5. Choose Next.

49

6. Choose the Select All Object Type option.
7. Choose Next.
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8. Select the following options:
o Folders and Objects
o Repository Objects
o Universes
9. Choose Next.

10. You can choose to select any of the three options. However, in the below screenshot, we
have retained the default option, as this gets all the instances of objects that was selected
from Web Intelligence or Crystal reports into the filter.

11. The Upgrade Management tool exports all the objects. However, you can choose to deselect the objects that you don’t want to migrate.
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12. If you retain the default options in Upgrade Options tab, then objects with the same CUID
in the destination would be overwritten. However, if you are migrating the objects for the
first time, then you can retain the default options, as it would not make much difference.

13. Choose OK to close the screen.
14. Choose Start.
After the upgrade is complete. The system displays following details:
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Iteration 3
This iteration illustrates the delta copy. In UMT, you can compare the source and the
destination FRS. You can use this feature to select objects, which are modified and new in the
source system within the provided time filter. You can also use this feature to perform time
based comparison of the modified object.
For example, let us assume that today is 5th January and the 1st migration was performed on
1st January .The users continued using the old machine. During this time span between (5th and
1st Jan) old machine consisted of few modified documents and also few new documents were
included. Now, if you run the UMT and select any folder to see the difference, then the
difference displays the objects that are modified and new.
However, in this iteration we are not going to check the modified and new universes, rather we
are going to observe the objects that were migrated in the previous iteration will not be listed.
But, the objects that were not migrated will be listed.
1. Select the time filter for Universe and Webi.
2. Choose Next.

Note: You know the path of recently modified objects in the source system. Alternatively, when
you manually traverse through all the folders and sub folders, you can only see the content that
has been modified within a specified date.
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3. The universes that are displayed in the below screenshot were modified in the source
system between 1st and 5th January.
4. Choose Export selected objects and their dependencies.
5. Choose Next.

All the dependencies with respect to the universes are displayed and automatically
selected.
6. De-select the dependencies manually as per your requirement.
7. Choose Next.
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You can see the progress bar indicating the progress of the migration.

If the upgrade is complete, you get a pop-up message notifying Upgrade Completed.
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Iteration 4
This iteration illustrates the migration of applications, calendars, corporate categories, profiles,
remote connections, repository objects and universes.
1. Choose the Select All Object Type option.
2. Select the Hide Objects which are already upgraded option. This will ensure that
objects that are migrated and present in the target system will not get reflected or
selected during the migration process.
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3. Choose Next.
4. Select the following object type:
 Applications
 Calendars
 Corporate Categories
 Profiles
 Remote Connections and Replication Jobs
 Repository Objects
 Universes
5. Choose Next.
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Note: If you have any of the other dependent objects, those objects are selected
automatically and is reflected in the next step.
6. You can manually select or de-select any object from the selected folders. To do so, you
must choose the object, so that the selected object appears on the right panel. Here,
you can select or de-select the appropriate objects by choosing the Apply to selected
objects option.
7. Choose Next.
You see a progress bar indicating the number of objects that are being retrieved.
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Minimum Temporary Space Required (941.82 MB) - The tool display the Minimum
Temporary Space required. This is temporary storage required in the target system. You
must have the minimum required space in the target system before you can proceed
with the migration.
8. Choose Start to proceed with the migration.
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Once the upgrade process is complete you get a pop-up notifying Upgrade Completed.
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Iteration 5
This iteration illustrates the migration of events, folders and objects, mobile subscriptions, and
QAAWS Objects.
1. Choose the Select All Object Type option.
2. Choose Next.
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3. You can migrate the following objects in this iteration:
 All public folders' content:
All the documents in public folders are chosen to upgrade in this stage. The documents
are available in Folders and Object listing in UMT. Upgrading documents in public folder
involves significant network, Disk I/O operations, as each file is read from the source
system, stored in a derby database by the UMT, computation of dependencies are done,
and then copied to the target systems' FRS location.
As, all the documents used by the enterprise is present here, the size of these folders
would be large. So, this consumes a significant amount of time for UMT to complete the
upgrading of documents to target system. Therefore, you can choose to upgrade the
documents in different increments. Following this pattern, you can choose to upgrade
the entire Folders and Objects in a single increment.
 QaaWS objects
All QaaWS objects are listed in the QaaWS Objects folder of UMT. When you select
QaaWS Objects folder automatically all the dependents are selected. All QaaWS
objects are chosen to upgrade with dependencies.
 Events
 Mobile Subscriptions
4. Choose Next
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5. Select Exporting pending/recurring instances of the content, which is present in the
Folders and Objects. This is a new feature in 4.2.However, you can select any of the
options according to your requirement.
6. Choose OK.
7. Choose Next.

You see a progress bar indicating the number of objects that are being retrieved.
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8. Choose Next.
9. Enter the Base_URL (http://<target system>:8080/dswsbobje/), of the target system
for QaaWS objects.
10. Choose Next.
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The Summary page appears, where all the selections that you have made is listed.
However, ensure that all the selections are made as per your requirement.
Note: As you have chosen to upgrade with dependencies, by default, all the User
Favorites folders, Universes and Repository objects are selected automatically. If any of
the objects are upgraded in the previous iteration, then users can de-select them.
However, retain the Users and User Groups as you need to retain the ownership/rights
assignment of the objects with the users.
11. Choose Start.
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12. Choose Ok.
13. Once the upgrade process is complete you get a pop-up notifying Upgrade Completed.
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Post Upgrade Steps
This chapter details the Post Upgrade steps.

Verifying Authentication Types
Verifying Third Party Authentication
Ensure Windows AD and SAP authentication types on the target machine.

Verifying Windows AD Authentication
1.
2.
3.
4.

Log on to CMC as an administrator.
On the CMC home page, select Authentication.
Double-click Windows AD.
Update authentication based on the user license.
Note: All the AD groups are updated during migration.
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5. To update concurrent license for Windows AD, you need to select following options:

Option

Description

Assign each new AD alias to an
existing User account with the
same name

This option updates Windows AD alias if the user
already exists with the same name.

Create new alias when the alias
update occurs

This option creates Windows AD users in the
destination machine when the update is clicked.

New users are created as
concurrent users

This option converts all Windows AD users as
concurrent users.
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Verifying SAP Authentication
During upgrade, SAP roles are upgraded from the source machine. These roles are upgraded as User
Groups in the target system.
1.
2.
3.
4.

Log on to CMC as an administrator.
On the CMC home page, select Authentication.
Double-click SAP.
Navigate to the Roles Import tab to synchronize the users with SAP roles into the destination
machine.
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Re-Starting all BI Servers
Restart all the servers that were stopped prior to upgrade. Ensure that all servers in all nodes
are up and running.

Creating Data Source Connections
You need to create all 64-bit Data Source Names (DSNs) and DB client configurations on target
machine. Because, UMT does not upgrade all the DSNs of the source machine to the
destination machine. These DSNs are required for the documents to refresh. You need to
manually create these DSNs in the target system similar to that of source system, to reestablish connectivity to the data-sources of the documents.

Verifying Security Model
It’s recommended to verify the security model, including folder security against users and
groups, once the upgrade process is completed and before releasing the system to end users.
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Testing & Validation
Testing in CMC
After successful execution of Iteration 1, When launch CMC, you must see the user and user
list.

Testing BI Launch Pad
Once the DSNs are properly created, and all the servers are up and running without any errors,
you can perform the following tests on the target machine:
o Compare security restrictions applied in the source and destination machines.
For example, in BI Launch pad application, security settings is properly migrated when
compared to the source as shown below:
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Testing Web Intelligence
For Web Intelligence application, security settings are properly migrated when verified with the
source as shown below:
To confirm if the security settings are migrated, perform the following:
1. log on to BI Launch pad as a user who is part of WebiUsers group
2. Check if the user is allowed to see only the content for which the user has view
permissions.
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There are many folders in the 1.Pattern_Book folder, but Webi users are only allowed to see
the Webi, Webi Analysts, and WebIntelligence_Analysts folders, which contains Web
Intelligence documents.
Check if webi users are allowed to perform the following actions on the documents:




Open BI documents such as, Web Intelligence, Crystal reports, and so on.
Refreshing BI documents.
Scheduling BI documents.

Enabling Services
Before upgrade, you need to enable the CMS DB auditing, which was previously disabled.

Running Platform Support Tool
Run the platform support tool to compare content of the target machine after upgrade.

Resume Scheduled Jobs
Before upgrade, all document schedules were paused in the source system. After the upgrade
all the document schedules are upgraded with the paused status. Therefore, you need to
resume all the paused document schedules.
1. Log on to CMC as an administrator.
2. In the CMC home page, select Instance Manager from the drop-down list.
3. Select the Status option and select Paused to filter all the schedules, which are in paused
status.
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4. Select all the instances and choose Resume from the menu bar.

Enabling Windows updates/anti-virus updates on all the machines
After the upgrade, you can enable Windows and anti-virus updates on the machines, which
were disabled earlier.
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Known Issues & Challenges
This section details the Known Issues and Challenges experienced during Iteration 1 and
Iteration 5.

Issues Experienced During Iteration 1

In this screen, since Crystal reports and OLAP intelligence reports are being upgraded, a
warning message is displayed asking users to confirm, if the Adaptive Processing server (APS)
hosting the multi-dimensional analysis service (MDAS), Crystal Reports 2016 Report Application
server hosting “Crystal Reports 2016 Viewing and modification service” are running and
enabled on the target system.
You can ignore the warning message, if the servers are already enabled in the target system.
Otherwise the servers need to be started (before proceeding with UMT next step) for migration
of Crystal reports and OLAP intelligence reports.


Here we need RAS processes on all nodes that are down, and all APS with MDAS services. In
our PB, we split the APS and created MDAS service on only 1 APS called APS_MDAS which
we started.
This is an exception that users experience while Promoting Lifecycle Manager as an
application from XI 3.1 to BI 4.2. However, Lifecycle Manager has been changed to
Promotion Management and Version Management as two distinct applications in BI 4.2.
Therefore, you can ignore this.
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OLAP connections must be recreated in BI 4.2 before running the Upgrade Management Tool.
The new connection name must be identical to the SAP Business Objects Enterprise XI 3.1 OLAP
connection. Otherwise the voyager workspace won’t get upgraded.

Object Failures
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You get the below error if the source file is corrupted. Therefore, check the source system for
functional or corrupted or deleted object. Alternatively, run RepoScan to rectify these errors.
For more information, see upgrade prerequisite section on how to run RepoScan.
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All output FRS errors are due to missing file / folder in the FRS. You get this error if the source
file is corrupted. Check the source system to know if the object is functional or corrupted or
deleted. Alternatively, run reposcan to rectify the error. For more information, see the upgrade
prerequisite section on how to run reposcan.

While upgrading users incrementally, UMT fails with timeout and CORBA connect errors as
shown below. To resolve this issue, see UMT time out resolution.
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If UMT is installed on a separate machine, ensure that the full build of BI4.2 SP01 is installed on the
same machine. Otherwise the following error occurs while upgrading reports: “The CrystalReport plugin does not exists (FWM 02016) ". To resolve this issue, uninstall UMT and reinstall full BI 4.2 SP01
Platform server on the machine and stop the SIA. These installed binaries help UMT to run with the
required behavior.

Note: Running UMT with incremental upgrade in the 2nd scenario took very long time (more
than a week), but finally upgrade was successful. Usually such scenario is not recommended
and unrealistic.

Issues Experienced During Iteration 5
As a pre-requisite, Analysis connections have to be created prior to migration. If the analysis
connections are not created then the reports or connections pertaining to the analysis object
fails.
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You get the below error if the entries are corrupt in the source system. Ensure that they exist in
the source system. Alternatively, you can run RepoScan and check the report.

The issue shown in below screenshot is a known issue in BI 4.2 SP1 and has been fixed in
SP2.The error occurs when you are trying to migrate AD user groups only from source keeping
the Windows AD authentication disabled in the source system.
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